Assignment 5

This week “work through” Excel Unit J. To “work through” means reading and
performing all hands-on exercises. The
exercises give detailed step-by-step instructions
with corresponding screen shot figures of the
Excel interface tabs, menus, toolbars, dialog
boxes, and correct output. You should perform
all of these to learn how to complete each skill.
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Customize a data series

Change a data source and add data labels
Format the axes of a chart

Add a data table to a chart

Rotate a chart

Enhance a chart with WordArt

Add a picture to a chart

Identify data trends
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Unit Study Tips

Quick Tip: You can also format a data series by clicking the data series on the
chart, clicking the Chart Tools Layout tab, then clicking the Format Selection
button.

Adding width and depth to data series:

You can change the gap depth and the gap width in 3-D bar or column charts by
right-clicking one of the data series of the chart then clicking Format Data Series
from the shortcut menu. With Series Option selected in the left pane of the
Format Data Series dialog box you can move the Gap Depth and Gap Width
sliders from No Gap or 0% to Large Gap or 500%. Increasing the gap width adds
space between each set of data on the chart by increasing the width of chart's
data series. Increasing the gap depth adds depth to all categories of data.

Quick Tip: You can also add data to a chart by selecting the chart and dragging
the corner of the data border to the right to include the new worksheet data.

Quick Tip: You can also add or delete data labels using the Data Labels button in
the Labels group on the Chart Tools Layout tab.



Representing proportional relationships:

Pie charts are often used to show the relative sizes of items in a data series by
displaying the proportional relationships of entities in a data series to the sum.
Pie charts represent the contribution of each value to a total in either a 2-D or 3-
D format. For example if you want to show the part of a budget a department
uses in an organization, you can create a pie chart and display the data labels as
percentages. The percentages represent the parts of the whole pie for each of
the departments.

To annotate a pie chart so it displays the percentage share of each item in a data
series, select the chart, click the Chart Tools Layout tab, click the Data Labels
button in the Labels group, select the position for the data labels, click the Data
Labels button again, click More Data Label Options, click the Percentage check
box to select it, deselect the Value check box, then click Close. Some of the
layouts in the Chart Layouts group of the Chart Tools Design tab also feature
percentage labels.

Moving, removing, and formatting legends:

To change the position of a legend or to remove it, click the Chart Tools Layout
tab, click the Legend button in the Labels group, then select the desired legend
position or select None to remove the legend. To format a legend’s position, fill,
border color and style, or shadows, click More Legend Options at the bottom of
the Legend menu. You can add textured fills or pictures and customize the
border and shadow characteristics. If you position the Format Legend dialog box
next to the legend, you can use the Excel Live Preview feature to try out different
effects, such as those shown in Figure J-5. To change a legend’s font size, right-
click the legend text, click Font on the shortcut menu, then adjust the font size in
the Font dialog box. You can also drag a legend to the location of your choice.

Quick Tip: You can change the scale of the axis: Click the Chart Tools Layout
tab, click the Axes button in the Axes group, point to Primary Vertical Axis, click
More Primary Vertical Axes Options, click the Fixed option button in the Major
unit group, then type the new scale interval value in the Fixed text box.

Quick Tip: You can also add a data table by selecting a chart with a data table
from the Chart Layouts gallery.

Quick Tip: To hide a data table, click the Data Table button in the Labels group,
then click None.

Using the Modeless Format dialog box:

Many of the buttons on the Chart Tools Layout tab have a “More ...Options *
command at the bottom of the menu that appears when you click them. For
example, clicking the Data Table button allows you to click More Data Table
Options. The Format —dialog box that opens when you click it allows you to




format the selected data table. But while the dialog box is open, you can also
click and format other elements. The Format dialog boxes are “modeless, which
means when they are open, you can click on other chart elements and then
change their formatting in the same dialog box, whose options adjust to reflect
the selected element. You are not restricted to changing only one object—i.e.,
you are not in a —single mode, or limited set of possible choices. For example if
the Format Data Table dialog box is open and you click a data label, the dialog
box changes to Format Data Labels. If you click the legend, the dialog box
becomes the Format Legend dialog box, allowing you to modify the legend
characteristics.

Quick Tip: You can also click the Up and Down buttons in the Rotation area of
the dialog box to rotate the chart up and down.

Making 3-D charts easier to read:

In addition to rotating a chart there are other ways to view smaller data points
that may be obscured by larger data markers in the front of a 3-D chart. To
reverse the order that the data series are charted you can click the Axes button
in the Axes group of the Chart Tools Layout tab, point to Depth Axis, click More
Depth Axis Options, click the Series in reverse order check box in the Format
Axis dialog box to select it, then click Close. Another way to see smaller data
series in the back of a 3-D chart is to add transparency to the large data markers
in the front of the chart. To do this you can right-click the data series that you
want to make transparent, click Format Data Series in the shortcut menu, click
Fill in the Format Data Series dialog box, click either the Solid fill or Gradient fill
option buttons, move the slider on the Transparency bar to a percentage that
allows you to see the other data series on the chart, then click Close. If you have
a picture on the chart's back wall, adding transparency to the series in front of it
makes more of the picture visible.

Charting data accurately:

The purpose of a chart is to help viewers interpret the worksheet data. When
creating charts, you need to make sure that your chart accurately portrays your
data. Charts can sometimes misrepresent data and thus mislead people. For
example, you can change the y-axis units or its starting value to make charted
sales values appear larger than they are. Even though you may have correctly
labeled the sales values on the chart, the height of the data points will lead
people viewing the chart to think the sales are higher than the labeled values. So
use caution when you modify charts to make sure you accurately represent your
data.

Quick Tip: To delete a chart title, right-click it, then select Delete from the
shortcut menu. You can also select the chart title and press [Delete].



Adding WordArt to a worksheet:

You can use WordArt to add interest to the text on a worksheet. To insert
WordArt, click the Insert tab, click the WordArt button in the Text group, choose a
WordArt Style from the gallery, then replace the WordArt text “Your Text Here”
with your text. After selecting the text, you can use the Text Fill list arrow in the
WordArt Styles group to add a solid, picture, gradient, or texture fill to your text.
The Text Outline list arrow in the WordArt Styles group allows you to add color,
weight, and dashes to the text outline. You can use the Text Effects button in the
WordArt Styles group to add shadows, reflections, glows, bevels, 3-D rotations,
and transformations to the WordArt text.

Rotating chart labels:

You can rotate the category labels on a chart so that longer labels won't appear
crowded. Select the Category Axis on the chart, click the Chart Tools Format tab,
click the Format Selection button in the Current Selection group, click Alignment
in the left pane of the —dialog box, click the Text direction list arrow, then select
the rotation option for the labels. In a two-dimensional chart, you can also select
a custom angle for the axis labels.

Creating a chart template:

After you create a custom chart with specific formatting, you can save it as a
chart template. Chart templates can be opened and reused later, and the applied
formatting will be available. Chart -templates have the file extension crix. If you
use a custom chart ~frequently, you can save the template as the default chart
type. To save a chart as a chart template, click the Chart Tools Design tab, click
Save As Template in the Type group, enter a filename in the Save Chart
Template dialog box, then click Save. Your chart template will be saved in the
Templates\Charts folder. When you want to format a chart like a chart template,
you need to apply the template. Select your chart, click the Insert tab, click a
chart type in the Charts group, click All Chart Types, click the Templates folder in
the Change Chart Type dialog box, select a template in the My Templates area,
then click OK.

Choosing the right trendline for your chart:

Trendlines can help you forecast where your data is headed and understand its
past values. This type of data analysis is called regression analysis in
mathematics. You can choose from four types of trendlines: Linear, Exponential,
Linear Forecast, and Two Period Moving Average. A linear trendline is used for
data series with data points that have the pattern of a line. An exponential
trendline is a curved line that is used when data values increase or decrease
quickly. You cannot use an exponential trendline if your data contains negative
values. A linear forecast trendline is a linear trendline with a two-period forecast.
A two-period moving average smoothes out fluctuations in data by averaging the
data points.
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! v SKII.LS REVIEW (CONTINUED) FIGURES-21
. 8. Ide tify data trends. :
~ a. Activate the Sales sheet and scroll to the top of the 2 e R Mar o Ape May . du
T oy, L o
1 b. Create a 2-W line chart us_ing the data iﬁ the range AZIG@; 5 Brownies $1,88% $1,732 £1,893 $1,523 §,889 51,838
then move anid resize the chart to fit in the range A8:G20. e R
¢. Add a linear trendLne to the Muffins data series. B w6000
d, Change the trendhﬁgcalor to red and the line style to dash. ::, S Y W
e. Set the forwagd option' 10 six periods to view the future T e
trend, thep’Compare yourcreen to Figure J-21. = - N/ o
f. Add youf name to the centerfooter section, save the work- o e e

Biscow

book¢'then preview and print the worksheet.
g. Exit Excel.
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. VINDEPENDENT CHALLENGE 1 |
You are the assistant to the vice president of marketing at the Metro-West Philharmonic located outside of Boston. The vice

',j president has asked you to chart some information from a recent survey of the Philharmonic’s customers. Your administrative
- assistant has entered the survey data in an Excel worksheet, which you will use to create two charts.

a. Start Excel, open the file titled EX J-3.xlsx from the drive and folder where you store your Data Files, then save it as
Customer Survey. ‘

b. Using the data in A2:B7 of the Education data worksheet, create a 3-D pie chart (the first chart in the 3-D Pie group)
on the worksheet.

¢. Add a title of Education Data above the chart. Format the title using Word Art Gradient Fill - Accent 6, Inner
Shadow.

d. Move the chart to-a separate sheet named Education Chart. Format the chart using chart Style 13. Add data labels
to the outside end of the data points. Format the legend text in 14-point bold. (Hint: Use the font options on the
Home tab or the Mini toolbar.) ‘

e. Select théBachelor’s degree pie slice by clicking the  geune J-22
chart, then clicking the Bachelor’s degree slice. e
Change the slice color to the standard color of pur-
ple. (Hint: On the Chart Tools Format tab, click the
Format Selection button in the Current Selection
group and use the Format Data Point dialog box.)
Compare your chart to Figure J-22

f. On the Family data worksheet, use the data in
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A2:B6 to create a standard clustered column (The oamibidiall
first chart in the 2-D Column group) chart. sl

g. Delete the legend. (Hint: Select the legend and press
[Delete].) ‘

h. Place the chart on a new sheet named Family

Chart. Format the chart using chart Style 5.

Add a chart title of Family Data above the chart =~ '

and format the title using WordArt Style Gradient Fﬂ} Black, Outline - White, Outer Shadow.

Title the category axis Number of Children. Format the Category axis title in 14-point bold. (Hint: Use the font

options on the Home tab or use the Mini toolbar.)

k. Enter your name in the center sections of the footers of the Family Chart and Education Chart sheets.

1. Save the workbook, then preview and print the Family Chart and the Education Chart sheets.

m. Close the workbook and exit Excel. ,
envancingCrarts A
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v INDEPENDENT CHALLENGE 2 \BL‘ T~

“You were vct ‘ ﬁem ployee of the m@nth for januar) at Caree:rs an empleyment agency. Your manager has asked you to assefti+
ble a brief presentanon on youz placements during January to show to the newly hired staff. You decide to mclude achatt
: 5h0wmg your p}acements in each of three job tategones techmcal busmess, and medzcal ;

a, Start Excei and save a new workbook as Careers in the cinve and folder where you store your Data Files. |
b. Enter Worksheet labels and your own data ona worksheet named January Placements Use Table} 2 as a guide for
the worksheet layout.
c. Create a clustered bar chart (the first chart in the 2-D Bar group) on the
worksheet, showmg your placements. Format the chart using Chart -
Style 11. Make sure the Office theme is selected. ; Job Category  Number of Placements
d. Display data values using Chart Layout 4. s B

TABLE J-2

e. Add a chart title of }anuary ‘Placements above the chart and format it Tecbmcai
BTSN ~ 2L ¥ic3 Business
using WordArt Style Fill - None, Outline - Accent 2. Medical

Delete the chart legend.
. Add new data to the worksheet for the Academic job category.
. Add the new data to the chart.

Move the chart toa sheet named January Chart.

Adda honzontal axm title of Number of Placements and format the title in 14-point bold font.
. Change the value scale if: necessary to fit your sales data and improve its readability.
. Adda data table to the chart. Formdt the data table lines to display in red.

Rl OB ~=-¢a -

Advanced Challenge Exermse 9
5 A ~ m Change the name of the chart’s data series name in the legend to Placements. (Hint: On the Chart Tools Design
N tab, usethe Select Data button and use the edltmg features in the Select Data Source dialog box. Change the exist:
E ing Series name to Placements.) :
- Use the Format Data Series dialog box to adda shadow with a format of your choice to the bars in the chart.
® Add abevel with a format of your choice to the bars in the chart.
m Change the fill color for the bars to one of the theme colors.

m. Enter your name in the center section of the January Chart sheet footer, save the workbook, then preview and print
the sheet. : 4
n. Close the workbook and exit Excel. |

¥ INDEPENDENT CHALLENGE 3 3\@%

You manage the Pine Hil]w Pm Shop You meet twice a year with the store owner to discuss store sales trends. You decide to.
use a chart to represent the sales trends for the department’s product categories. You begin by charting the sales for the first |
- five months of the year. Then you add data to the chart and analyze the saies trend using a trendline. Lastly, you enhance the |

chart by addmgadata lal}le mles an(la pitturc Ity ~ o] i ;
: | |

a. Start Excel, open the file EX 5-4 xlsx from the drive and f@idez where you store your Data Files, then save the work-
book as Golf Sales. :
b. Create a 2-D line chart on the worksheet showing the }anuary thxough May sales mformatzgn Move the
chart and resize it if necessary.
~¢. Format the Clubs data series and the Cart rentals data series using colors of your choice.
~d. Add the June data from Table} 3 to the Worksheet Add the June data series to the chart.
e. Move the chart to its own sheet named Jan - June and add a data tabie wﬁhout 1egend keys. Format the
data table line color using 1 the color of your choice.
f. Adda chart title of january june Sales using the Centered Overiay posmon Pormat the chart title
using the WordArt Style of your choice.

TABLE J-3 4

. Enhancing Charts



V INDEPENDENT CHALI.ENGE 3 (CONTINUED) 1

g Add a rotated title of Sales in zﬁepomt bold tothe verncal axis.
h Add a linear trendhne to the Clubs data senes

i. Change the color of the trendline to red and format the width in 2-pt dash style.
j. Insert the golfball.gif picture from the drive and folder where your Data Files are stored into the legend area of the chart.

Advanced Challe nge Exercise ,f

and a color if né €S$ary, SO that the legend text is readable.

K. Enter your name in the center footer section of the chart sheet, save the workbook, then preview and print the chart.
L. Close the workbook and exit Excel.

V REAL LIFE INDEPENDENT CHALLENGE

Stock charts are used to graph a %ck’s {f’ , and closing prices. You will create a stock chart using four weeks of high,
low, and close prices for a stock that 9 are 1nterested in tracking.

a. Start Excel, save a new wo oo Stock Chart in the drive and folder where you store your Data Files.
. Use the search engine gt your to research the high, low, and close prices for a stock over the past four weeks.
c. Create a worksheepvith the data frqm your chart. Use Table J-4 as TABLE J-4

=2

e pIot area and add a chp art background Adjust the transparency of the legend background

£00Z [39x3 |

a guide for the worksheet structure. Apply a document theme of
your choice. . ; — s
d. Create a High-Low-Close stock chart usigg/}éér worksheet data. Date - High  Low - Close
(Hint: To find the stock chauts, click the @ther Charts button.)
e. Format the horizontal axis to thangefhe major unit to seven days.
f. Change the color of the h1gh~10w to the standard color of

Stock Name

8. Add a rotated vertical axis #

h. Delete the chart legend

1. Add a chart title w}t}rour stock name. Format the title with a WordArt style of your choice from the WordArt Styles
gallery. ‘ ~ ,

j- Add data labels above the data . (Hint: Use’the Data Labels button on the Layout tab } Delete the High and Low
labels but keep the Close data }abeisk ‘Add gAf

K. Format the chart area using a gradient ad transparencv of your choice. Format the piot area w1th aclip art fﬁl related
to the company or its product. Adjus! the clip art transparency as necessary to view the chart.

1. Enter your name in the center foefer section of the worksheet, save the Workboc}k then preview and print the sheet in
landscape orientation on one glage.

m. Close the workbook and exft Excel.

dark red. ; f
'e of Stt;}t;l’rice. Format the title in 14-point bold.

Enhancing Charts m |




